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FEATURES 

Full-featured evaluation board for the AD7908, AD7918, and 

AD7928 devices 

Evaluation control board (EVAL-CONTROL-BRD2) compatible 

Standalone capability 

On-board analog buffering and voltage reference 

Various linking options 

PC software for control and data analysis when used with the 

EVAL-CONTROL-BRD2 

GENERAL DESCRIPTION 

This document describes the evaluation board used to test the 

AD7908, AD7918, and AD7928 ADCs. Packaged with each 

EVAL-AD7908/AD7918/AD7928 is a sample box containing 

one AD7908, one AD7918, and one AD7928 ADC. Place the 

ADC to be tested into the socket of the evaluation board. 

The AD7908, AD7918, and AD7928 ADCs are high speed  

8-bit, 10-bit, and 12-bit, respectively, successive approximation 

ADCs. These parts operate from a single 2.7 V to 5 V power 

supply and feature throughput rates of up to 1 MSPS. Refer to 

the AD7908/AD7918/AD7928 data sheet in conjunction with 

this document. 

On-board components for this evaluation board include  

• One AD780, which is a pin programmable 2.5 V or 3 V 

ultrahigh precision band gap reference 

• One REF192 2.5 V reference 

• One AD712 dual op amp 

• One AD713 quad op amp 

Various link options are explained in Table 1.  

Interfacing to the evaluation board is through a 96-way 

connector that is compatible with the evaluation control board 

(EVAL-CONTROL-BRD2), which is also available from Analog 

Devices, Inc.  

External sockets are provided for REFIN, SCLK, DIN, DOUT, 

and CS signals. In addition, the evaluation board includes two 

bias-up circuits for bipolar input signals and eight sockets (VIN0 

to VIN7) for the analog input channels. 
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Figure 1. 
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EVALUATION BOARD HARDWARE 
LINK OPTIONS 

There are 28 link options to be set before using the evaluation board. The functions of the options are outlined in Table 1. 

Table 1. Link Functions 

Link No. Function 

LK1 to LK8  Connects the inputs of the AD713 to the input sockets (VIN0 to VIN7) or ties the AD713 inputs to AGND.  
Position A: Each AD713 input is connected to the relevant input socket.  
Position B: Each AD713 input is connected to AGND. 

LK9  Selects the source of the 12 V supply for the EVAL-AD7908/AD7918/AD7928.  
Position A: The 12 V supply is sourced from the EVAL-CONTROL-BRD2 via the 96-way connector.  
Position B: The 12 V supply is sourced externally via the J2 connector. 

LK10  Selects the source of the −12 V supply for the EVAL-AD7908/AD7918/AD7928.  
Position A: The −12 V supply is sourced from the EVAL-CONTROL-BRD2 via the 96-way connector.  
Position B: The −12 V supply is sourced externally via the J2 connector. 

LK11  Selects the source of the voltage applied to the REFIN pin of the AD7908/AD7918/AD7928 and to the bias-up circuits.  
Position A: The REF192 supplies the 2.5 V reference to the AD7908/AD7918/AD7928.  
Position B: The AD780 supplies the 2.5 V reference to the AD7908/AD7918/AD7928. 

LK12  Selects the source of the data applied to the DIN pin of the AD7908/AD7918/AD7928.  
Position A: The data is provided from the EVAL-CONTROL-BRD2.  
Position B: The data is provided from an external source applied via the DIN SMB socket. 

LK13  Selects the source of the VDD supply to the AD7908/AD7918/AD7928.  
Position A: The supply voltage is provided from an external source via J5.  
Position B: The supply voltage is provided from the EVAL-CONTROL-BRD2 via the 96-way connector. 

LK14  Selects the source of the CS signal for the AD7908/AD7918/AD7928.  

Position A: The CS signal is generated by the EVAL-CONTROL-BRD2 via the 96-way connector.  

Position B: The CS signal is applied from an external source via the CS SMB socket. 

LK15  Connects the data output pin, DOUT, of the AD7908/AD7918/AD7928 to the EVAL-CONTROL-BRD2 or to an external SMB socket.  
Position A: The DOUT pin is connected to the EVAL-CONTROL-BRD2.  
Position B: The DOUT pin is connected to the external DOUT SMB socket. 

LK16  Controls the program pin of the AD780 voltage reference.  
When this link is inserted, the AD780 output voltage is set to 3.0 V.  
When this link is removed, the AD780 voltage is set to 2.5 V. 

LK17  Selects the source for the SCLK signal applied to the SCLK pin of the AD7908/AD7918/AD7928.  
Position A: SCLK is applied from an external source via the SCLK SMB connector.  
Position B: SCLK is an inverted signal from the EVAL-CONTROL-BRD2.  
Position C: SCLK is sourced directly from the EVAL-CONTROL-BRD2. 

LK18  Selects the source for the VDRIVE voltage.  
Position A: VDRIVE is connected to AVDD of the AD7908/AD7918/AD7928.  
Position B: VDRIVE is provided from the EVAL-CONTROL-BRD2 via the 96-way connector.  
Position C: VDRIVE is provided from an external source via the external J4 connector. 

LK19 to LK28 Adds a 51 Ω termination resistor to AGND at the VIN0 to VIN3 input sockets.  
When a 51 Ω termination is required, these links should be inserted. 
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OPERATING THE EVALUATION BOARD 

The evaluation board can be used either as a standalone board 

or it can be operated in conjunction with the EVAL-CONTROL-

BRD2. When operated with the EVAL-CONTROL-BRD2, all 

supplies and control signals to operate the AD7908/AD7918/ 

AD7928 are provided by the EVAL-CONTROL-BRD2. 

Software to communicate between the control board and the 

AD7908/AD7918/AD7928 is provided with the evaluation 

board kit. The EVAL-CONTROL-BRD2 operates with all 

Analog Devices evaluation boards with model numbers ending 

in the letters CB. 

Power Supplies 

When using this evaluation board with the EVAL-CONTROL-

BRD2, all supplies are provided from the control board through 

the 96-way connector. 

When using the board as a standalone unit, external supplies 

are required. This evaluation board has seven power supply 

inputs: EXT_VDD, AGND, +12 V, −12 V, AGND, VDRIVE, and 

DGND. If the evaluation board is used in standalone mode, a 

2.7 V to 5 V supply must be connected to the EXT_VDD input. 

The +12 V and −12 V supplies are required for the op amps. 

The VDRIVE input can be connected to a supply from 2.7 V to 5 V, 

allowing the evaluation board to be connected to both 3 V and 

5 V systems. The supplies are decoupled to the ground plane 

with 10 μF tantalum and 0.1 μF multilayer ceramic capacitors  

at the point to the board. The supply pins of all the op amps, the 

reference, and the AVDD pins of the AD7908/AD7918/AD7928 are 

decoupled with 10 μF tantalum and 0.1 μF ceramic capacitors. 

INITIAL SETUP CONDITIONS 

Before applying power or signals to the evaluation board, care 

should be taken to ensure that all link positions are as per the 

required operating mode. Failure to do this may result in damage 

to the evaluation board.  

Table 2 outlines the default positions of all links when the board is 

shipped. The links are set so that all power supplies and control 

signals are supplied by the EVAL-CONTROL-BRD2.  

Table 2. Initial Link Positions 

Link No. Position Function 

LK1  A  Input of AD713 is connected to the VIN0 SMB socket.  

LK2 to LK8  B  AD713 inputs are connected to GND.  

LK9  A  The +12 V supply is generated by EVAL-CONTROL-BRD2.  

LK10  A  The −12 V supply is generated by EVAL-CONTROL-BRD2.  

LK11  B  The AD780 supplies the 2.5 V reference to the AD7908/AD7918/AD7928.  

LK12  A  Data applied to the DIN pin of the AD7908/AD7918/AD7928 is generated by EVAL-CONTROL-BRD2. 

LK13  B  VDD is supplied from EVAL-CONTROL-BRD2.  

LK14  A  The CS signal is generated by EVAL-CONTROL-BRD2.  

LK15  A  The DOUT pin is connected to EVAL-CONTROL-BRD2.  

LK16  OUT  The AD780 voltage is set to 2.5 V.  

LK17  C  The SCLK signal is sourced directly from EVAL-CONTROL-BRD2.  

LK18  B  VDRIVE is generated by EVAL-CONTROL-BRD2.  

LK19 to LK28  OUT  A 51 Ω termination on the inputs is not added.  
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INTERFACING THE EVALUATION BOARD 

Interfacing the evaluation board to the EVAL-CONTROL-BRD2 or 

another system is accomplished via a 96-way connector, J1. Plug 

the 96-way connector of the evaluation board directly into the 

96-way connector of the EVAL-CONTROL-BRD2. 

The 96-way connector is powered from a 12 V ac transformer. 

Suitable transformers, including the following, are available from 

Analog Devices as accessories: 

• EVAL-110VAC-US: for use in the U.S. or Japan 

• EVAL-220VAC-UK: for use in the U.K. 

• EVAL-220VAC-EU: for use in Europe 

Other suppliers also offer compatible transformers, including 

Digi-Key Corporation (U.S.) and Campbell Collins, Ltd. (U.K.).  

Connection between the EVAL-CONTROL-BRD2 and the 

parallel port of a PC is via a standard Centronics, Inc., printer 

port cable, which is provided as part of the EVAL-CONTROL-

BRD2 package. Refer to the manual that accompanies this package 

for more details.  

Figure 2 shows the pinout for the 96-way connector, and Table 3 

and Table 4 list the pin descriptions and designators.  
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Figure 2. Pin Configuration for the 96-Way Connector, J1 

Table 3.  

Pin  Description  

DR  Data Receive. Serial data from the device is provided at 
this output. Sixteen bits of data are provided with a 
leading zero, three channel address bits, followed by 
twelve bits of conversion data, which are provided MSB 
first for the AD7928 (see the device data sheet for 
information on the AD7918 and AD7908). 

DT  Data Transmit. Serial data from the DSP is provided at 
this pin. Twelve bits of data are provided MSB first. 

SCLK  Serial Clock Zero. This continuous clock is connected to 
the SCLK pin of the AD7908/AD7918/AD7928 via LK17 
to obtain serial data from the device. 

TFS0  Transmit Frame Sync Zero. 

RFS0  Receive Frame Sync Zero. Both the TRS0 and RFS0 inputs 
are connected to the AD7908/AD7918/AD7928 CS pin 
to initiate conversions and frame the serial data transfer. 

DGND  Digital Ground. These lines are connected to the digital 
ground plane of the evaluation board and allow you to 
provide the digital supply via the connector and the 
other digital signals. 

AGND  Analog Ground. These lines are connected to the 
analog ground plane of the evaluation board.  

AVDD  Analog +5 V Supply. These lines are connected to the 
AVDD supply line of the evaluation board via LK13.  

+12 V  +12 V Supply. This line is connected to the +12 V supply 
line of the evaluation board via LK9.  

−12 V  −12 V Supply. This line is connected to the −12 V supply 
line of the evaluation board via LK10.  

Table 4. 96-Way Connector Pin Functions1

Pin No. Row A  Row B  Row C  

1     

2     

3     

4  DGND  DGND  DGND  

5  DT0   DR0  

6  TFS0   RFS0  

7  SCLK0   SCLK0  

8     

9     

10     

11     

12  DGND  DGND  DGND  

13     

14     

15     

16  DGND  DGND  DGND  

17     

18     

19     

20  DGND  DGND  DGND  

21  AGND  AGND  AGND  

22  AGND  AGND  AGND  

23  AGND  AGND  AGND  

24  AGND  AGND  AGND  

25  AGND  AGND  AGND  

26  AGND  AGND  AGND  

27   AGND   

28   AGND   

29  AGND  AGND  AGND  

30  −12 V  AGND  +12 V  

31     

32  AVDD  AVDD  AVDD  
 
1 The unused pins of the 96-way connector are not shown. 
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SOCKETS 

There are 20 input/output sockets relevant to the operation of the AD7908/AD7918/AD7928 with this evaluation board. The functions of 

these sockets are outlined in Table 5. 

Table 5. Socket Functions 

Socket  Function  

J1  96-way connector for serial interface and power supply connections.  

J2  External +12 V, −12 V, and AGND power connector.  

J3  External VDRIVE connector.  

J4  Subminiature BNC socket for bipolar input signal to Bias-Up Circuit 0.  

J5  External VDD and AGND power connector.  

J6  Subminiature BNC socket for output from Bias-Up Circuit 0. Unipolar signal.  

J7  Subminiature BNC socket for bipolar input signal to Bias-Up Circuit 1.  

J8  Subminiature BNC socket for output from Bias-Up Circuit 1. Unipolar signal.  

VIN0 to VIN7  Subminiature BNC sockets for analog input Channels 0 to 7.  

REFIN  Subminiature BNC socket for REFIN voltage.  

SCLK  Subminiature BNC socket for external SCLK.  

CS  Subminiature BNC socket for external CS.  

DIN  Subminiature BNC socket for external DIN.  

DOUT  Subminiature BNC socket for DOUT signal.  
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EVALUATION BOARD SOFTWARE 
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Figure 3. Main Dialog Box 

INSTALLING THE SOFTWARE 

The EVAL-AD7908/AD7918/AD7928 kit includes a CD-ROM.  

When the CD is inserted into the PC, an installation program 

automatically begins. This program installs the evaluation software.  

THE MAIN DIALOG BOX 

The software that controls the EVAL-CONTROL-BRD2 and 

therefore the AD7908/AD7918/AD7928 evaluation board consists 

of three dialog boxes. The main dialog box—the AD7928/18/08 

Evaluation Software dialog box, shown in Figure 3, allows you 

to read a predetermined number of samples from the evaluation 

board and display the samples in both the time and frequency 

domain. This dialog box can be divided into three sections.  

The top section of the dialog box contains the control buttons, 

the menu bar, and the status windows. 

Control Buttons 

Use the control buttons to sample data (Sample), reset the 

board (Reset), and retrieve information about the software.  

Click Reset to cause the EVAL-CONTROL-BRD2 to perform a 

reset. During a reset, the power supply to the evaluation board is 

turned off, and the program in the DSP memory is lost. If required, 

set up the board again to download another program. Click Quit to 

exit the software. Note, however, that this will not terminate the 

program running on the EVAL-CONTROL-BRD2.  

Menu Bar 

The menu bar consists of the File, Printer Port, Control 

Register, Sequence1, Sequence2, and Help drop-down menus.  

The File drop-down menu offers the following selections: 

• Setup Menu. Select this option to display the Setup Menu 

dialog box, as shown in Figure 5. 

• Load Raw Data. Select this option to load data saved by 

the software during a previous session. 

• Save Raw Data. Select this option to save the current set of 

sample data points. The data can be reloaded to the evaluation 

software later or can be used by other programs for analysis. 

• Save Binary Data. Select this option to save the current set 

of sample data points. The data is saved in binary format as a 

text file. This method can be useful for examining code flicker 

and identifying stuck bits, that is, bits that are not changing. 

• Save FFT Data. Select this option to save the current set  

of FFT data points. FFT data cannot be reloaded into the 

EVAL-CONTROL BRD2 software, but can be loaded into 

other software packages for further analysis. 

• Exit. Quits the program. 
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The Printer Port drop-down menu allows you to select the printer 

port used to communicate with the EVAL-CONTROL BRD2.  

• LPT1. This option selects 0x378 as the printer port base 

address. This is the default option. 

• LPT2. This option selects 0x278 as the printer port base 

address.  

• PRN. This option selects 0x3BC as the printer port base 

address.  

Set up the operating conditions for the device using the Control 

Register drop-down menu. After you select the conditions, a 

12-bit word is sent to the AD7908/AD7918/AD7928 control 

register on the next serial transfer. 

The Sequence1 and Sequence2 menus are inactive in this 

version of software. 

The Help drop-down menu provides information about the 

current version of software for the evaluation board. 

Status Boxes 

The status boxes display the setup of the evaluation board, the 

number of samples taken, and any messages generated. 

Oscilloscope 

The middle section of the main dialog box is a digital storage 

oscilloscope (DSO). It can display samples uploaded from the 

EVAL-CONTROL-BRD2. Samples can be displayed as integer 

values or as voltages. After samples are displayed, click any 

point in the graph to display the sample number and value of 

that point. Along the axis of the graph are sizing handles that 

allow you to zoom in for a closer look of a sample, if required. 

When another set of samples is taken, the graph attempts to 

display all values collected unless the Hold Zoom check box is 

selected. If Hold Zoom is selected, the graph retains the same 

axis settings as the previous set of data samples. Additional 

check boxes are provided so that you can control the vertical 

and horizontal grids and the data points. 

Fast Fourier Transform/Histogram 

The lower section of the main dialog box can display a fast 

Fourier transform (FFT) of the data or a histogram, which 

shows the number of occurrences of each code readback. The 

FFT (default option) is typically used for assessing an ADC’s 

performance in the frequency domain, whereas the histogram is 

used to assess the ADC’s performance with dc signals. The option 

displayed can be switched by clicking FFT Mode/Histogram 

Mode at the upper right of the dialog box. Figure 4 shows the 

main dialog box when the Histogram Mode option is selected. 
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Figure 4. Main Dialog Box, Histogram Mode 
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SETUP MENU 

The Setup Menu, shown in Figure 5, allows you to load the 

required configuration file for the evaluation board. When the 

configuration file is loaded, the software acquires detailed infor-

mation about the evaluation board and the ADC connected to 

EVAL-CONTROL-BRD2. This includes information such as  

the number of bits, maximum sampling rate, type of output coding, 

maximum analog input, and power supply requirements.  

The configuration file also indicates to the software the name of 

the DSP program file to download to the EVAL-CONTROL-

BRD2. The Setup Menu allows you to choose the sampling 

frequency and the number of samples.  

CHECKING THE EVAL-CONTROL-BRD2 

The EVAL-CONTROL-BRD2 and the evaluation board should 

be connected together as described in the Interfacing the 

Evaluation Board section. 

At this stage, the red LED on the EVAL-CONTROL-BRD2 

should be flashing. This indicates that the EVAL-CONTROL-

BRD2 is functional and ready to receive instructions.  

Note that the software should be installed before the printer 

port cable is connected between the EVAL-CONTROL-BRD2 

and the PC. This ensures that the printer port has been 

initialized correctly.  

USING THE SOFTWARE 

After the hardware and software is set up 

1. From the File menu, select Setup Menu.  

A setup form displays. A list box on the Setup Menu lists 

the available configuration files. The configuration files are 

text-based files containing information about the ADC to 

be tested (AD7908.cfg, AD7918.cfg, and AD7928.cfg).  

2. Select the relevant configuration file and click Load.  

Choose the configuration file depending upon which device is 

in the socket of the evaluation board. The EVAL-CONTROL-

BRD2 is reset, and the DSP program is downloaded. After 

the download is complete, the power supply settings indicated 

in the configuration file are set and you may hear some of 

the relays clicking. The drop-down list boxes, Select No. 

Of Samples and Select Sample Frequency, are set to the 

default values specified in the configuration file. Note that 

you can change these settings at any point.  

3. After all the settings are set, click Close to return to the 

main dialog box. 

Default Conditions 

The EVAL-AD7908/AED7918/AD7928 is configured to convert 

on Channel 0 in normal mode with straight binary output coding 

and a 0 to REFIN input range. If no changes are made to the 

control register via the Control Register drop-down menu on 

the main dialog box, clicking Sample yields conversion results 

from Channel 0. 
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Figure 5. Setup Menu Dialog Box 
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Taking Samples 

To instruct the EVAL-CONTROL BRD2 to obtain the required 

number of samples at the required frequency, follow these steps 

using the main dialog box, shown in Figure 3: 

1. Click Sample. 

Select a sampling frequency up to the rate of 1 MSPS.  

Samples are uploaded and displayed. An FFT and 

histogram are also calculated and displayed.  

2. Click Cont Sample to continue taking samples.  

To stop sampling, click Cont Sample again. Note that 

while the software is continuously sampling data, the other 

control buttons are disabled. 

3. Click Exit to stop the process.  

Software Configuration Files 

Software configuration files provide the EVAL-CONTROL-

BRD2 software with information on how the software and 

hardware should perform. These files contain information, such 

as the name of the DSP program to download, the default and 

maximum sampling frequencies, the number of samples to take, 

and the power supply settings to use.  

What follows is a typical software configuration file (*.cfg). 

[EVAL-CONTROL BOARD] 

partname:AD7928 

programname:ad7928.PRG 

samplefrequency:100000 

maxsamplefrequency:1000000 

samples:2048 

 

+/−15V:on 
dvdd:5:on 

avdd:5:on 

bus:on 

;options 2scomp, binary 

dataformat:binary 

numberofbits:12 

inputVmax:2.5 

inputVmin:0 

[endofconfig] 

Sequencer Modes: FFT Mode and Histogram Mode 

FFT Mode 

To operate the EVAL-AD7908/AD7918/AD7928 in FFT mode 

with the sequence and shadow bits set to 11 in the Control 

Register drop-down menu, follow these steps: 

1. Select the 11 combination from the Shadow/Seq bits in the 

Control Register drop-down menu.  

2. Select the final channel in the sequence.  

3. After the control register configuration is set, click Sample.  

When the evaluation board is finished taking samples on the 

selected channels in the sequence, the resulting FFTs are displayed 

in the lower section of the main dialog box. SNR:, THD:, and 

FREQ: show results that correspond to the final channel in the 

programmed sequence. 

If individual SNR, THD, and frequency results are required from 

each individual channel, operate the device in normal mode with 

the sequence and shadow (Shadow/Seq) bits set to 00 and select 

the individual channel in the Control Register drop-down menu. 

Histogram Mode 

When operating the evaluation board in histogram mode with 

the sequence and shadow bits set to 11 in the Control Register 

drop-down menu, follow these steps: 

1. Select the 11 combination for the Shadow/Seq bits in the 

Control Register drop-down menu.  

2. Select the final channel in the sequence.  

3. After the control register configuration is set, select Sample.  

When the evaluation board is finished taking samples on the 

selected channels in the sequence, the resulting histogram displays 

in the lower portion of the main dialog box. The histogram cor-

responds to the first channel in the programmed sequence. Max 

Code:, Min Code:, Spread:, Std Dev:, and Mean: show results 

that correspond to the first channel in the programmed sequence. 

If you want the codes, such as the maximum code and the mini-

mum code, to correspond to a particular channel, operate the ADC 

in normal mode with the sequence and shadow (Shadow/Seq) bits 

set to 00 and select the individual channel in the Control Register 

drop-down menu. 
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EVALUATION BOARD SCHEMATICS AND ARTWORK 

06218-006

 

Figure 6. Schematic 1 
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Figure 7. Schematic 2 
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Figure 8. Component Side Artwork 
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Figure 9. Solder Side Artwork 
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Figure 10. Component Placement Drawing 
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ORDERING INFORMATION 
BILL OF MATERIALS 

Table 6. Components Listing 

Qty  Reference Designator  Part Type/Description  PCB Decal  Supplier No.1  

1  U1  8-channel, 1 MSPS, 8-/10-12-bit  
ADCs with sequencer 

TSSOP-16  Analog Devices AD7908/ 
AD7918/AD7928 

2  U2, U3  Quad precision, low cost,  
high speed BiFET op amps 

SOIC16NB  Analog Devices AD713  

3  U4, U5, U8  Dual precision, low cost,  
high speed BiFET op amps 

SOIC8NB  Analog Devices AD712  

1  U6  Tiny logic high speed inverter SOT23-5  FEC 685-914  

1  U7  2.5 V/3.0 V ultrahigh precision  
band gap voltage reference 

SOIC8NB  Analog Devices AD780  

1  U9  Precision micropower, low dropout,  
low voltage reference 

SOIC8NB  Analog Devices REF192  

10  R1 to R10  51 Ω resistors  805  FEC 321-7905  

10  R11 to R20  1 kΩ resistors 805  FEC 911-859  

2  R21, R22  3 kΩ resistors 805  FEC 321-8119  

22  C1 to C12, C14 to C16,  
C19, C21, C23, C25,  
C26, C28, C34  

0.1 μF capacitors  805  FEC 499-687  

20  C17, C18, C20, C22, C24,  
C27, C29, C35 to C47  

10 μF tantalum capacitors  CAP\TAJ_B  FEC 197-427  

1  C13  1 μF capacitor 805  FEC 317-640  

4  C30 to C33  68 pF capacitors 603  FEC 722-066  

1  C34  10 nF capacitor 805  FEC 499-225  

2  D1, D2  Schottky diode DO35  Vishay SD103C 

17  DIN, CS, DOUT, J4, J6, J7, J8,  
REFIN, SCLK, VIN0 to VIN7 

50 Ω gold-plated PCB SMB jacks  SMB  FEC 310-682  

1  J1  CON\41612\96  DIN41612-96  FEC 104-986  

1  J2  3-pin power connector  CON\POWER3  FEC 151-786  

2  J3, J5  2-pin power connectors  CON\POWER  FEC 151-785  

15  LK1 to LK15  4-pin headers (2 × 2) Headers FEC 511-791  

1  LK16  Jumper  SIP-2P  FEC 511-705  

10  LK19 to LK28  Jumpers  SIP-2P  FEC 511-705  

2  LK17, LK18  6-pin headers (2 × 3)  Headers FEC 511-780  

14  LK1 to LK14  Shorting links   FEC 528-456  

5  T1 to T5  Testpoints  Testpoints  FEC 240-333  

1  X1  Clamp-SOIC-TSSOP  Clamp   

4  Each corner  Stick-on feet  3M  FEC 651-813  
 
1 FEC = Farnell Electronic Components®. 
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ORDERING GUIDE ESD CAUTION 

Model Description 

EVAL-AD79x8CB AD7908/AD7918/AD7928 Evaluation Board 
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